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Introduction 

Welcome to NiceLabel 

NiceLabel is a family of professional labeling software products that brings a 

complete bar code printing solution and RFID Smart Label printing to desktop, 

mobile and enterprise users. NiceLabel offers an easy-to-use interface and meets any 

label design and printing requirement for efficient label printing solutions to users in 

retail, logistics, health care, chemical, automotive and other industries. The main 

product lines include NiceLabel Suite, NiceLabel Pro, andNiceLabel Express. 

NiceLabel can be used with any 32-bit or 64-bit Windows operating system: 

Windows 2000, Windows XP, Windows Server 2003 and Windows Vista.  

The latest software is available for free download on the NiceLabel website at 

www.nicelabel.com. 

  

Contents of the Package 

Before starting the installation of the NiceLabellabeling software check the contents 

of the package to ensure it is complete. The package must include: 

 NiceLabelCD 

 Installation Guide 

 Quick Start Guide 

 Software key, or optionally a hardware key (not available with all editions) 

If any of the mentioned items are missing, please contact your software vendor 

immediately for package replacement. 

About this Manual 

About this Manual 

The User Guide helps you design and print labels quickly. 

The User Guide contains the following sections: 

Introduction: This chapter will introduce you to NiceLabel software. 

Installation and Activation: Learn how to install and activate the labeling software. 

Setting up NiceLabel Software: Learn how to set up and customize software to your 

preferences. 
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Designing Labels: Learn how to create labels. You should refer to this chapter 

regularly while designing labels, until you have completely familiarized yourself with 

the commands. By using the information contained in this chapter, you will be very 

quickly able to use labeling software efficiently. 

Printing and Previewing Labels: Learn how to print and preview labels. 

Technical Support: Contacting technical support. 

Software Restrictions 

All features explained in the Quick Start Guide are available in the NiceLabel Suite 

edition. However, some features are not available in the NiceLabel Pro or NiceLabel 

Express editions. Sections discussing features not available with NiceLabel Pro or 

NiceLabel Express will display an alert icon. 

Typographical Conventions 

Text that appears in bold refers to menu names and buttons like the OK button. 

Text that appears in italic refers to options, confirming actions like Read only and 

locations like Folder. 

Text enclosed in <Less-Than and Greater-Than signs> refers to keys from the desktop 

PC keyboard like <Enter>. 

Variables are enclosed in [brackets] like [variable]. 

Product Overview 

NiceLabel Software Products 

NiceLabel is a family of professional labeling software products that brings a 

complete bar code printing solution and RFID Smart Label printing to desktop, 

mobile and enterprise users. Software offers an easy-to-use interface and meets any 

label design and printing requirement for efficient label printing solutions to users in 

retail, logistics, healthcare, chemical, automotive and other industries. 

NiceLabel family of products offers the following: 

 Standard Series 

 Represent the most complete range of “standard” labeling software 

 Easy to use but offers powerful functions expected from advanced label 

designers 

 Unique selling points: NiceForm, NiceWatch& Pocket NiceLabel 

 Tight control over printing process – NicePrintQueue & bi-directional 

drivers, reprint functionality 

 Enterprise Series (Products for enterprises and toughest demands) 

 NiceLabel Print Center 

 NiceWatch Enterprise 

 Developer Series (Integration solution for software publisher - "print engine") 
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 NiceLabel SDK: SDK for software publishers, who need label printing 

capabilities in their software. NiceLabel SDK can be embedded in 

existing information systems or existing applications to provide support 

for label printing. NiceLabel SDK provides all label printing functionality 

of the software. 

 NiceLabel PocketSDK 

 NiceLabel WebSDK 

NiceLabel Express 

Wizard-based software meeting basic bar code labeling needs. The entry-level 

software includes many design elements of the NiceLabel Pro edition with the 

emphasis on simplified user interaction. 

NiceLabel Pro 

Full-featured software designed for professional label design and printing, including 

complete database support and ActiveX integration possibilities. A wide range of 

features and options makes NiceLabel Pro a perfect and easy-to-use tool for any 

labeling requirement. 

NiceLabel Pro includes the following modules: 

 NiceLabel Pro: Main application for label design and printing. 

 NiceMemMaster: Download fonts and graphics to the computer’s memory 

card for optimized label printing. 

 NiceData: Manage your databases. 

NiceLabel Pro is available in Print Only edition as well. 

NiceLabel Suite 

NiceLabel Suite is a complete software solution for any kind of label design and print 

requirement. Multiple connectivity options allow users to perform stand-alone 

printing or integrate label printing into any network environment. 

NiceLabel Suite offers interactive label printing capabilities such as integrating label 

printing into existing applications (ActiveX) or non-programming embedding of label 

printing to existing systems (NiceWatch). 

NiceLabel Suite includes the following programs: 

 NiceLabel Pro: Main application for label design and printing. 

 NiceForm: Create your own custom designed data-entry applications without 

requiring any programming skills. 

 NiceWatch: Integrate and automate label printing to any existing information 

system. 

 NiceMemMaster: Download fonts and graphics to the printer's internal 

memory or memory card for optimized label printing. 

 NiceData: Manage your databases. 

 NicePrint: Manage fast and easy label printing. 

 NicePrintQueue: manage your print jobs. 
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NiceLabel Suite is available in Print Only edition as well. 

For detailed information about a particular program please refer to User Guide, 

available on the product CD and web site. 

Pocket NiceLabel 

Pocket NiceLabel is a program package for Windows CE that brings the power of 

label printing to portable Windows CE computers (Windows Mobile Device). 

NiceLabel Pocket PC Designer 

NiceLabel Pocket PC Designer is a software package for desktop Windows computers 

that brings the power of label and form design to Windows mobile devices. After you 

have designed the required labels on the desktop PC, synchronize the labels with the 

Windows mobile device and print them from the Windows mobile device. 

NiceLabel Print Center 

NiceLabel Print Center is enterprise-level labeling solution with centralized control 

over all clients in the network. The enterprise edition manages the printing process 

centrally while label design and printing occurs locally on the client computers 

hosting NiceLabel Suite.  

The NiceLabel Print Center software performs the following: 

 Centralized print and event logging. 

 Centralized control over printers and print queues (print jobs). 

 Centralized logging of executed NiceWatch actions. 

 Issuing alerts through email, NetSend, Instant Messenger, RSS feed, SMS or 

pager. 

 Flexible licensing for clients. 

The NiceLabel Print Center is comprised of two main components: 

 NiceLabelEnterprise Print Manager, installed on server, 

 NiceLabel Suite, installed on client computers. 

The NiceLabel Print Center edition can be used with 32-bit and 64-bit Windows 2000 

and Windows 2003 server families. 

NiceWatch Enterprise 

Centralized label printing middleware software that integrates the label printing 

process into enterprise-level products, such as Enterprise Resource Planning (ERP) 

systems, Warehouse Management Systems (WHS) and others. 

The NiceWatch Enterprise performs the following: 

 Multi-threaded label printing execution to ensure fast and stable operation in 

heavy-load environments (where a lot of print requests happen simultaneously).  

 Remote administration to view list of triggers, start and stop triggers. 

 Centralized logging of executed actions. 

NiceWatch Enterprise includes the following modules: 
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 NiceWatch Server 

 Enterprise Print Manager (EPM) 

NiceWatch Enterprise also includes one NiceLabel Pro license. You will use 

NiceLabel Pro for label design. 

The NiceWatch Server edition can be used with 32-bit and 64-bit Windows 2000 and 

Windows 2003 server families. 

NiceLabel SDK 

NiceLabel SDK is an ActiveX integrator edition of software developed for software 

publishers who need label printing capabilities in their software. NiceLabel SDK can 

be embedded in existing information systems or existing applications to provide 

support for label printing. NiceLabel SDK provides all label printing functionality of 

the software. 

NiceLabel WebSDK 

NiceLabel WebSDK is the label printing solution for web applications. Similar to 

NiceLabel SDK it is developed for software publishers who integrate label printing 

functionality into their web applications. 
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Installation and Activation 

System and Software Requirements 

Single User Edition 

To run the program you need at least the following: 

 Pentium based computer with at least 128 MB of free RAM 

 One of the 32-bit or 64-bit Windows operating systems: Windows 2000, XP, 

2003 and Vista 

 Hard disk with 75 to 250 MB of free disk space (depending on the installation 

options) 

 CD-ROM drive 

 Support for OLE DB database drivers. Recent Windows operating systems have 

included OLE DB database drivers. If your operation system does not have the 

database support, the installation wizard will prompt you to install it. 

 Administrator rights to the local computer during installation 

Installing Software 

Installing Software 

When you put the product CD in your CD-ROM drive, the installation/demonstration 

program will start automatically. You can browse the directory of the CD, look at the 

brochures and technical documentation, sample files and other documents. 

Note: 

If you are using Windows 2000, XP or 2003, you have to log on with 

Administrator rights to be able to perform installation. 

Run START.EXE 

Use the installation wizard to install the labeling software on your desktop PC. To 

install the labeling software, do the following: 

1. Put the product CD in your CD-ROM drive. An installation window will open 

automatically. 

Note: 
If the installation wizard does not start automatically, go to the main CD directory of 

your product CD and double-click on the file START.EXE. 

2. Click on Install. A new window will open showing all available software 

editions. 

3. Click on the software edition you want to install. Follow the prompts. 
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Note: 
Make sure to select the appropriate installation type in the installation wizard. The 

same installation wizard is used for all software editions. 

Close All Software Applications 

To ensure complete installation of the labeling software, close all open software 

applications before you start installing the labeling software. 

Define Setup Options 

You can select the components of the selected software edition that you want to 

install. You can choose among the following three types of installations: 

 Full Installation - installs all software components in all available languages. 

 Compact Installation - installs only minimal set of components required for 

software to work correctly. Help and sample files are not installed. 

 Custom Installation – gives you the option to select individual components for 

installation. 

To continue installation, do the following: 

1. Click on the Next button. 

2. Specify the program group you want to use for the labeling software. 

3. Specify if shortcuts to labeling software should be created on the desktop or in 

Quick Launch area. 

4. Click on the Install button to finish the installation. 

5. The Start menu in your Windows will show a new program group for the 

labeling software that contains shortcuts for all applications. 

Install Printer Driver 

Install Printer Driver 

You can use the labeling software to design and print labels to standard office printers 

(laser, inkjet or matrix) or to professional label printers (thermal printers). If you own 

a thermal printer, you have to install the appropriate printer driver before you can 

print with the label printer. You will find NiceDrivers for all major thermal printer 

brands on the product CD and on the product website. 

You can install a printer driver for your thermal printer in the following three ways: 

 Install within the labeling software installation.  

 Use the Printer Installation Wizard. 

 Use the Windows Add Printer Wizard. 

Printer installation within software installation 

To continue installing the NiceDriver after setup has finished the labeling software 

installation, do the following: 

1. Select the option Install printer driver. 
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2. Click on the Finish button. 

3. Printer Installation Wizard will open. 

4. Select your printer from the list. Click on the Next button. 

5. Select the port where you have connected your printer and click on the Finish 

button. 

Note: 
This type of printer installation is available only when running installation from the 

product CD. 

  

Printer Installation Using the Printer Installation Wizard 

1. Put the product CD in your CD-ROM drive. The main installation application 

should start automatically. If not, start Windows Explorer, browse to the CD 

and double click on the file START.EXE. 

2. Click on Installation. A new window will open showing all software editions 

and printer drivers. 

3. Click on NiceDrivers. The printer installation wizard will start. 

4. Select your printer from the list. Click on the Next button. 

5. Select the port where you have connected your printer and click on the Finish 

button. 

Note: 
If you have downloaded the installation for NiceDriver from the product web site, run 

the downloaded executable file and follow the steps four (4) and five (5). 

  

Printer Installation Using the Windows Add Printer Wizard 

1. Open Control Panel from Settings option in Start menu. 

2. Open Printers (Printers and Faxes) and select Add a Printer. 

3. Follow the Add Printer Wizard prompts. The actual steps vary depending on the 

version of your Windows operating system. It is only important to click on the 

Have disk button in the step where you can select printer manufacturer and 

model. 

4. Put the product CD in your CD-ROM drive (if not already done so) and browse 

to the folder \Drivers.  

5. Select the folder of your printer name and click on Open/OK buttons to return 

to the Add Printer Wizard. You will see the list of all available printer models 

of the selected printer. 

6. Select your model, click on the Next button and finish the installation. 

Note: 
Windows 2000, XP and Vista might prompt you to cancel the installation process 

because NiceDrivers do not have the digital signature by Microsoft. It is safe to 

continue with the installation at this point. NiceDrivers have not been certified by 
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Microsoft but have been subject of intensive pre-release testing and comply with 

Microsoft's demands for printer drivers. 

  

Activating Software 

Activating Software 

The following activation instructions work for single-user and network editions. 

You have to activate the software if you want to use it. If you do not complete the 

activation process, the software will run in demo mode. 

The Product Activation utility will always run after installation. If you want to change 

the activation type or add more licenses to your network edition, you can also start 

activation from the labeling software. Select Help -> Manage License. 

There are the following types of the software activation:  

 Hardware key activation 

 Single-user Software key activation 

 Network Software key activation 

Note: 
NiceLabel SE, NiceLabel Express and NiceLabel Pro editions do not have the 

network licensing, or Enterprise Print Manager license server. 

Hardware key activation: The software editions with hardware key can be used 

immediately after installation. If you have a software edition with a hardware key, 

please skip ahead to the chapter Activate the Software with a Hardware Key.  

Single-user Software key activation: The software editions with a single-user 

software key need to run the activation application in order to obtain full 

functionality. The Software Key number is a sequence of 25 characters.  

Network Software key activation: You can activate the server part of the Network 

edition the same way as editions that come with a single-user software key. The 

Network Software Key number is a sequence of 25 characters. Activating the server 

part will also activate the client on the current workstation. If you upgrade the 

network edition with additional users, you have to install and activate each additional 

workstation separately. Please refer to the chapter Activate Additional Network 

Clients. 

Enterprise Print Manager license server: You can activate the labeling client with 

the license coming from the Enterprise Print Manager (EPM). Enterprise Print 

Manager is available with the Enterprise Series edition NiceLabel Print Center. 

Before you can activate the client, you must activate the NiceLabel Print Center. 

../../../Content/Installation_and_Activation/Activating_Software/Activate_Additional_Network_Clients.htm
../../../Content/Installation_and_Activation/Activating_Software/Activate_Additional_Network_Clients.htm
../../../Content/Installation_and_Activation/Activating_Software/Activate_Additional_Network_Clients.htm
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Activate Software with a Hardware Key 

You can activate the single user editions with a parallel or USB key. However, you 

cannot activate the network edition with a hardware key!  

Make sure you have finished installing the software on your PC when you activate 

your single user edition with a hardware key. 

Activate the with a Parallel Key 

 

To install a parallel key, do the following: 

1. Shutdown your computer and switch off your printer. 

2. Connect the hardware key directly to the parallel port (marked as LPT or PRN 

port) on your computer. 

3. Make sure you connect the hardware key in such a manner that pins on the key 

plug into the holes in the computer port. Fasten the two screws to secure the 

key. 

Note: 
Do not remove the screws or try to turn them inside out. 

Never try to connect the key to a serial port on the computer or directly to a printer. 

You can permanently damage the hardware key as well as your computer equipment. 

3. Start the labeling software. A Warning window will open. 

4. Click on the Manage License button. The Manage License window will open. 

5. Select Activate the package and click on Next. 

6. Select Hardware Key and click on Next. A new Manage License window will 

open showing the key license information for your labeling software. 

7. Click on the Finish button and the labeling software will start in full working 

mode. 

Note: 
If you own a serial printer, you cannot connect the printer to the hardware key directly 

because the connectors are not compatible. Always connect your serial printer to the 

serial port and hardware key to the parallel port. Your printer does not need to print 

"through" the hardware key. 

Activate the labeling software with a USB Key 
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To activate the labeling software using a USB key, do the following: 

1. Plug the USB key into an available USB port. 

2. Start the labeling software. A Warning window will open. 

3. Click on the Manage License button. The Manage License window will open. 

4. Select Activate the package and click on Next. 

5. Select Hardware Key and click on Next. A new Manage License window will 

open showing the key license information for your labeling software. 

6. Click on the Finish button and labeling software will start in full working 

mode. 

Activate Single User Edition 

You can activate the labeling software automatically through the Activation Server or 

manually through the activation Key Number Activation Web site. The activation on 

the Web only works with single-user software key and network software key. If the 

computer that uses the labeling software is not connected to the Internet, you will 

have to open the Activation Web page on a computer with Internet access to obtain 

the activation information. 

Before you start the activation process of the labeling software, get familiar with the 

following terminology: 

 Key number: The sequence of 25 characters provided with the labeling 

software. 

 Registration number: Unique number generated during the activation process. 

The registration number validates the entered software key. 

 Activation code: Issued on the labeling activation Web site. The activation 

code activates the labeling software on your computer. 

To activate the labeling software, do the following: 

1. After the installation is complete, run the labeling software. The Warning 

window will open. 

2. Click on Manage License. The Manage License window will open. 

3. Select Activate the package and click on Next. 
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Selecting 'Single-user Software Key' activation 

2. Select Single-user Software Key and click on Next.  

3. Enter the required customer information and the key number.  

4. Click on the Next button. The window Manage License – Activation Code will 

open. 

5. To activate the software automatically, click on the link Connect to the 

Activation server (recommended).  

6. To activate the software manually, click on the Internet link for Web page 

activation. Your Internet browser will open the Key Number Activation Web 

site. 

 Enter the key number and the registration number. Enter other user 

information, if prompted. 

 Click on the Activate button to retrieve the Activation code. 

 Copy the Activation code and paste it in the field Activation Code in the 

open Manage License – Activation code window of the opened labeling 

software. 

7. Click on the Next button and follow the prompts to complete the activation 

process. 

Note: 
You can still activate the labeling software if the computer does not have access to the 

Internet.  
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If the computer where you installed the labeling software does not have Internet 

access, do the following: 

1. Follow the steps one (1) to four (4) from the previous section. 

2. Write down the Key number and the Registration number. 

3. Write down the Internet activation Web address. 

Note: You can also click the button Save Data and store the activation information to 

the text file. It will save you some time as you do not have to write down the numbers. 

4. Go to a computer with Internet access and open the activation Web site in the 

Internet Explorer. 

5. Enter the Key number and the Registration number. Enter other user 

information when prompted. 

 

Internet activation website 

6. Click on the Activate button to retrieve the Activation code. Write it down. 

Note: 
The Key and Registration numbers, the Activation code and information in other 

fields are case-sensitive, so be careful when writing it down. 

7. Go back to the client computer where the window Manage License is still open. 

8. Enter the Activation code. 
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9. Click on the Next button and follow the prompts to complete the activation 

process. 

  

Move the Software License to Another Computer 

The labeling software will run in unlimited mode on each computer, where you have 

activated the labeling software. You can activate the software with a hardware key, or 

software key (single user or multi-user license). 

To move the software license to another computer when you have the hardware key, 

do the following: 

1. Disconnect the hardware key (USB or parallel port variant) from your 

computer. 

2. Install the labeling software on the new computer. 

Follow the steps in the topic Installing Software. 

3. Activate the labeling software on the new computer. 

Follow the steps in the topic Activate Software with a Hardware Key. 

To move the software license to another computer when you have the software key 

(25-character number), do the following: 

1. Run NiceLabel Pro on currently active computer. 

2. Select Help -> Manage License. 

3. Enable the option Manage current software key license. 

4. Click Next. 

5. Select the option Deactivate License and click Finish. 

Selecting this option will remove the license from your computer and store it 

back to the activation server. 

Note: The computer must have access to the internet to be able to transfer the license 

to the activation server. 

6. Install the software on the new computer. 

Follow the steps in the topic Installing Software. 

7. Activate the software on the new computer. 

Follow the steps in the topic Activate Single User Edition. 

Installing Upgrades 

Overview 

You can upgrade the labeling software in the following ways:  

 Upgrade software within one version (minor version upgrade), for example 

from 5.0.0 to 5.1.0. 

 Upgrade software version from an older version to the most current one (major 

version upgrade), for example 2.1.0 to 3.0.0. 
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 Upgrade software edition, for example NiceLabel Pro to a more advanced 

edition like NiceLabel Suite. 

Install Minor Version Upgrade 

In a software minor version upgrade, you upgrade an older minor version, for 

example 3.0.0, to the latest version of 3.x.x. Before you upgrade your labeling 

software, make sure you 

 Backup your label files. 

 Do not remove the existing version from your desktop PC. 

 Check which software edition you have. 

Note: 
To check your software edition, look at the label on your CD case or start the software 

and select Help -> About. 

To upgrade your stand-alone/ single user software (minor version upgrade), do the 

following: 

1. Close the labeling software on your desktop PC. 

2. Disable your Virus Scan software. 

3. Install the new minor version in the same folder where the old version is 

currently installed. The new version will replace the old one. 

4. Follow the prompts. 

Install Major Version Upgrade 

In a labeling software major version upgrade, you upgrade an older version, for 

example 2.x.x, to the latest version of 3.x.x. Before you upgrade the labeling software, 

make sure you 

 Backup your program files. 

 Do not remove the existing version from your desktop PC. 

 Check which edition you have. 

Note: 
To check your software edition, look at the label on your CD case or start the software 

and select Help -> About. 

To upgrade your stand-alone/ single user software (major version upgrade), do the 

following: 

1. Close the labeling software and any other software on your desktop PC. 

2. Disable your Virus Scan software. 

3. Put the product CD in your CD-ROM drive. 

4. Install the same software edition as you already have; for example, if you have 

NiceLabel Pro 2.1.x and want to upgrade to NiceLabel Pro 3.x.x, install 

NiceLabel Pro 3.x.x.  

5. Follow the prompts. 
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Install Edition Upgrade 

When you perform an edition upgrade, you want to upgrade to a more powerful 

software edition; for example upgrade from NiceLabel Express to NiceLabel Pro or 

NiceLabel Pro to NiceLabel Suite. Before you upgrade your labeling software, make 

sure you  

 Backup your program files. 

 Close the labeling software and any other software on your desktop PC. 

 Do not remove the existing labeling software edition. 

To upgrade your stand-alone/ single user software edition, do the following: 

1. Put the product CD in your CD-ROM drive. 

3. Install the new edition (Pro or Suite) on your computer. Follow the same 

instructions as for first-time installation. Refer to the chapter Installing the 

Labeling Software.  

4. Follow the prompts. 

Note: 
Activate the new edition of the labeling software when you have received the 

activation document from your vendor with the upgrade package. You won’t be able 

to use the new edition until you have activated it. 

Activating Upgrades 

Activate Minor Version Upgrade 

When you upgrade to a new minor version of the the same edition, for example 

NiceLabel Pro version 3.x.1 to NiceLabel Pro version 3.x.2, the software will remain 

activated. Just make sure you install the new version in the same folder as the existing 

version. Please follow the same instructions as described in the chapter Install the 

Minor Version Upgrade.  

Note: 
For the network edition make sure to install the server part in the same folder on the 

server that is currently used for the Network edition. You will not have to activate the 

server again. It will remain activated from the previously installed build. 

Activate Major Version Upgrade 

When you upgrade to a new major version of the same edition, for example 

NiceLabel Pro version 2.1.x to NiceLabel Pro version 3.x.x, you will have to activate 

the software again. The new version does not override the existing one and you can 

work with both the old and new version of the same edition. Please follow the same 

instructions as for the first-time installation of the labeling software in the chapter 

Installing the Software. 

Summary of required steps: 

1. Close running labeling applications. 
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2. Do not remove the existing version of labeling software. 

3. Install the new version of the same edition you already have. 

4. If your software (old version) has a hardware key (USB or Parallel, see chapter 

Activating the Software), plug the key in your computer. 

5. Activate the new the version with the upgrade key number. 

Note: 
To upgrade your software version 2.1.x to version 3.x.x, you need to have available 

both the old 25-digit serial number (for version 2.1.x) and the new 25-digit software 

key number (for version 3.x.x). Both keys are required to activate your software 

upgrade.  

To activate the new version, do the following: 

1. Open the newly installed labeling software. A Warning window will open. 

2. Click on the Manage License button. The Manage License window will open.  

Note: 
If you activate the labeling software immediately after completing the installation, 

select Activate the package and click on Next. 

3. Select Single User Software Key and click on Next. A new Manage License 

window will open showing the key license information of your old version of 

labeling software. 

Note: 
If your old software came with a USB or Parallel key, plug the key into an available 

port, select Hardware Key and click on Next. 

4. If your software is protected by a software key, select Manage current 

software key license and click on Next. 

If your software is protected by a hardware key, select Manage current 

hardware key license and click on Next. 

5. In the Manage License – Manage software key license window, select Upgrade 

key license and click on Next. 

6. In the Manage License – Upgrade code window, enter the Upgrade Key 

Number you received from your vendor. 

7. To activate the software automatically, click on the link Connect to the 

Activation server (recommended). 

8. To activate the software manually, click on the provided Internet link for Web 

page activation. Your Internet browser will open the Upgrade Activation Web 

site. 

 Enter user information and click on ACTIVATE. A new window will 

open with the generated Activation Code. 

 Copy the Activation code from the Web site and paste it in the field 

Activation Code in the open Manage License – Activation code window 

of the open the software. 

9. Click on the Next button and follow the prompts to complete the activation 

process. 
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Note: 
You can still activate the software if the computer does not have access to the 

Internet. Please refer to the chapter Activate the Single User Edition. 

Activate Edition Upgrade 

When you upgrade to a new edition of the labeling software, for example from 

NiceLabel Express to NiceLabel Pro or NiceLabel Pro to NiceLabel Suite, you keep 

the existing software edition on your computer and install and activate the new 

software edition. Please follow the same instructions as for the first-time installation 

of the labeling software in the chapter Installing the Software. To activate the new 

edition of the labeling software, follow the activation instructions discussed in the 

chapter Activating the Major Version Upgrade. 

Note: 
To upgrade your software edition, you need to have available the old 25-digit serial 

number/ software key and the new 25-digit software key number. Both keys are 

required to activate your upgrade. 

Summary of required steps: 

1. Close all labeling software applications. 

2. Install the new edition of the software. 

3. Activate the new edition with the upgrade key number. 

  

Limitations of the Demo Mode 

Registering the Software 

At the end of the activation process, please fill out the registration form in the last step 

of the Product Activation process. If you have the access to the internet, the product 

can be activated on-line. You can also print out the registration form and send or fax it 

to the contact on the form. 

Registration is not required but you should register the labeling software to receive 

the following benefits: 

 Free access to downloads and updates. 

 Free Technical Newsletter discussing product news. 

To register the labeling software, do the following: 

1. Start the label designer. 

2. Select Help -> Manage Registration. 

3. Follow on-screen instructions. 
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Setting Up the Software 

User Interface 

Main Window 

This is labeling application main window. 

 

  

Mouse Wheel support 

If you have mouse, that has a wheel in place of the middle button, you can use it to 

speed-up zooming and scrolling a lot: 

 Turning the wheel, scrolls the label up or down. 

 Holding <SHIFT> and turning the wheel scrolls the label left or right. 

 Holding <CTRL> and turning the wheel, zooms the label in or out. 
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Shortcuts 

Delete Deletes selected object 

Ctrl + X Cut 

Ctrl + C Copy 

Ctrl + V Paste 

Alt + 

Backspace 
Undo 

+ (on 

numeric 

pad) 

Zoom In 

- (on 

numeric 

pad) 

Zoom Out 

Alt + Shift 

+ 

Backspace 

Redo 

Ctrl + T Rotate 90° 

Ctrl + A Align 

Ctrl + Z Undo 

Ctrl + Y Redo 

Ctrl + N New 

Ctrl + O Open 

Ctrl + S Save 

Ctrl + P Print 

Ctrl + R Print preview 

Ctrl + 

move the 

object with 

mouse 

Parallel moving of the object by main axes only. 

Alt + move 

the object 

with mouse 

Objects snap to grid even if it is off. 

Ctrl + 

move the 

object with 

cursor keys 

Fine tuning the position of the object. 
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Shift + 

cursor keys 
Fine tuning the dimensions of the object, resize width and 

height in very small steps. 

Right-

clicking the 

object 

Opens pop-up menu with shortcuts to commands. The content 

of the pop-up menu greatly depends on where you clicked your 

mouse button and what was selected at that time. 

Enter 

F2 or 

double-

click 

Opens properties dialog box of the selected element. 

Using the Keyboard and Mouse Effectively 

When selecting objects you can use <CTRL> key to adjust object's anchoring point by 

clicking the object placeholders. 

If you have a Wheel Mouse, you can use the wheel to scroll label up and down. 

Holding <CTRL> when rotating the wheel adjusts zoom factor, <SHIFT> scrolls 

label left or right. 

Double click on printer's name in status bar opens printer properties dialog box in 

which you can set various options regarding currently selected printer. If you hold 

<CTRL> while double clicking, printer setup dialog box is opened, in which you can 

select different printer. 

You can quickly move objects from one open label to another by simply dragging 

desired object to another window while holding <ALT>. If you want to copy objects 

instead, hold both <ALT> and <CTRL>. Note that you must have both label windows 

visible to do that. 

Different objects on label can be selected using the <TAB> and <SHIFT>+<TAB> 

keys. 

Pressing cursor keys while holding <Ctrl> key can move currently selected object. 

This can be used to fine-tune position of the object. Holding <SHIFT> while pressing 

cursor keys will resize the object. 

You can use the right mouse button almost anywhere on label to access most common 

options for that area/object. For example, if you click an object with right mouse 

button, a pop-up menu is displayed that contains options and actions that can be 

performed on selected object. Similarly clicking the other parts of label produces pop-

up menu with options for that part of label. 

Multiple objects can be selected by holding <SHIFT> while clicking them. 

Use the element shortcuts in toolbars whenever possible. Each label element that can 

be connected to some Contents Provider, has a shortcut enabled to quickly access 

existing variables or define new ones. Click the element's shortcut handle for this 

shortcut. It is shown as a small arrow by the side of some toolbox icons. 
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System folder 

The labeling application uses its system folder for storing files needed to run the 

program. The location of the folder varies depending on the Windows operating 

system used. 

The location of the System folder is C:\Documents and Settings\All Users\Application 

Data\EuroPlus\Express 5\system. 

It is vitally important to own the write access to this folder on your computer system 

and the right to write to and modify files in this folder. 

Note: 
The Network clients use the System folder on the network server. If you have 

Network edition all clients must have the full access also to the System folder on the 

server. 

The labeling software stores important system settings in the System folder, as 

follows: 

 User data and user rights 

 Custom application settings 

 Label printing logs 

 Bar code standards 

 Definition of global variables (GLOBALS.TDB). 

Welcome Wizard 

When you start the labeling software a Welcome Wizard will be shown. It provides a 

quick access to most used commands when starting working on a label layout. 

Create a new 

label 
A blank label will be created and Label Setup Wizard will be 

started. You will be able to design a new label from a scratch. 

Open recently 

used label 
A list of recently used labels will be displayed to provide a 

quick access to commonly used labels. 

Open some other 

existing label 
A common Windows dialog box will open to let you browse 

for the appropriate label file. 

  

Use Project Folders 

You should always design the appropriate folder layout on disk for your label 

projects. With that in mind you can increase your work efficiency significantly and 

always know where certain types of files are stored. The applications also finds 

required files faster this way. 
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Using consistent folders is important with more demanding projects, where you have 

a lot of labels, databases, pictures and printing forms. Of course, you can always 

change the file location in application preferences (Tools -> Options). But this 

approach is not really recommended, when you work with different projects and do 

not want to mix the files between the projects. 

You should do the following: 

1. Make a separate folder for each project, you are building, e.g. Project1. 

2. Beneath this folder make the following subfolders. 

 Database (for databases) 

 Forms (for forms) 

 Graphics (for images) 

 Labels (for labels) 

Note: Use the English names for the folders. 

3. Store appropriate files in each of these subfolders. 

4. Do not change any folder location in application preferences (Tools -> 

Options). 

When the applications will require some file the relative links between the files is 

always the same. Even if you copy the main project folder to some other location or 

disk, the relative links between the subfolder Database, Forms, Graphics and Labels 

remain the same. 

For example: The image is placed on the label. The original image location was 

c:\My Project 10\Grahics\logo.jpg on your local disk. When the label project for the 

customer is complete, you copy the folder structure "My Project" to the customer's 

computer and rename it to "Labels". The location is d:\Labels. Because you use the 

subfolders, the relative link between the label in Labels folder and the image logo.jpg 

in the Graphics folder is the same. The application can find the image. 
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Designing Labels 

Using Label Setup Wizard 

Using Label Setup Wizard 

Label Setup Wizard offers defining dimensions of the label and changing printer 

setup. It consists of a few simple steps. Click on the Related Topics button for more 

information. 

Selecting Printer 

 

Label setup Wizard - Selecting printer 

Select desired printer and optionally click Properties button if you want to set the 

printer parameters. Print setup dialog box is shown, allowing you to set the printer 

parameters such as print speed, print darkness and print direction. Note that this is 

standard Widows printer setup dialog box and its options may differ from printer to 

printer as it is based on the printer driver. 

If the check box Always use default printer is checked, the default window's printer 

and its settings will be used always when opening this label. 

Click the Next button to continue with the next step. 



Designing Labels     
      
      

  

30 

NiceLabel Express User Guide 

Stock 

 

Label setup Wizard - selecting Label Stock 

If you use one of the standard predefined label formats, you can specify it here. 

Stock Type: Select the type of stock. 

Stock name: Select the stock from the list. 

Stock information: The information about label dimensions, printer settings, 

background images as defined by the selected stock. 

Label linked to stock: If you enable this option, you cannot change the dimensions 

of the label, because the stocks locks the dimensions. 

Note: 
Using pre-defined stocks simplifies the process of label creation as you do not have to 

define the label dimensions manually. 

Click on the Next button to continue with the next step. 
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Defining the Page Size 

 

Label setup Wizard - choosing Label Dimensions 

Select the page size for your labels. This step is only necessary for the office printers. 

Automatic Sizing: Tick this option, if you are using thermal printer with 

NiceDrivers. The labeling software and NiceDrivers will negotiate about the label 

dimensions. 

Click on the Next button to continue with the next step. 



Designing Labels     
      
      

  

32 

NiceLabel Express User Guide 

Selecting Label Orientation 

 

Selecting label layout 

Orientation: Select the label orientation. Look at the screen and printer layouts for 

suggestion how the label will really be printed from the printer. 

Print directions: Tick the option Rotated to rotate the label for 180 degrees, when 

printed. 

Click on the Next button to continue with the next step. 

Defining Label Dimensions 

Here you can enter the label dimensions. 

Note: 
The values for dimensions are entered automatically if you selected the label stock in 

the previous step. 
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Label setup Wizard - defining the label format 

Width, height: Define the label dimensions. 

Margins: Define the label margins. 

Rows, columns: Define the number of labels in horizontal and vertical directions. 

This option is commonly used with office printers (laser and inkjet printers). 

Gaps: Define the gaps between the labels. 

Note: 
Define gaps only if you have changed rows and columns option. If you have rolls of 

labels, the gaps between the labels are auto-identified by the gap sensor in the printer. 

Unit of measure: Change the unit of measure you want to use. 

When you are satisfied with the label dimensions, click on the Finish button to close 

the Label setup wizard. 

Designing a Basic Label 

Overview 

In this section you will learn how to design a simple label file with fixed and variable 

objects. The variable objects can obtain values from several sources. You will learn 

how to: 
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 Provide object values with a keyboard prompt. 

 Obtain object values from a database.  

 Preview the label on the screen. 

 Print the label. 

The label you create will look like this: 

 

Basic label 

Create a Basic Label 

Create a New Label 

To create a basic label, do the following: 

1. Open the labeling software. 

2. Select New label under File menu or click on the icon   in the standard 

toolbar. 

Each time you create a new label, a Label Setup Wizard will start to help you setup 

the label and connect to the printer. 

Note: 
You can leave the Wizard at any time and accept the default settings for the label by 

clicking on the Finish button. 

Select a Printer 

1. Select the printer you want to use for label printing. 

Note: 
If you don’t find your printer on the list, refer to chapter Install Printer Driver for 

installation instructions. 
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Selecting a printer 

2. Click on the Next button.  

Define Label and Page Dimensions 

1. If you want to use the label stock, select your choices in the window Select 

Stock.  

2. Click on the Next button. A new window will open to define the label 

dimensions manually. 

3. Leave the option Page Size on 'User defined' default and check Automatic 

Sizing.  

4. Click the Next button. A new window will open. 

5. Select label orientation and print direction.  
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Selecting label layout 

6. Click on the Next button. A new window will open. 

Enter 10 for label width and 7 for label height. 

Note: 
Dialog box differs from thermal and office printers.  
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Defining label dimensions 

Note: 
To change the unit of measure from centimeters to inches or other supported units, 

click on the button with unit of measure below the label preview in the dialog box. 

7. Click on the Finish button. New empty label will open. 

Enter Non-Changing Text 

1. Click on the   button in the Toolbox. The text cursor appears on 

the screen. 

 

Cursor for text object 

2. Move the cursor to the location on the label where you want to place the text 

object and click on the mouse button. 

The dialog box with object properties will open. 
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3. Enter the text "SAMPLE" and click on the Finish button. 

 

Entering content for text object 

4. Click on the text object to select the object. 

5. Change the font for the text object using the Text toolbar. 

Choose Arial font, 28 point size and bold style. 

  

Using format options in the text toolbox 

6. To change the position and size of the text object, select the text object and drag 

object with your mouse to the position where you want to have it. 

The screen should show the following: 
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The text object is placed on the label 

Insert Bar Codes 

Now you will add a non-changeable Code128 bar code on the label. 

1. To insert the bar code, click on the  button in the Toolbox. 

2. Move the cursor to the desired position on the label and click on the mouse 

button.  

3. The dialog box with object properties will open. 

4. Enter the value 1234567890 for the bar code contents. 

5. Click on the Define button. 

Edit Bar Code dialog box opens. 

6. Make sure you select bar code Code128 and click on the OK button. 

 

Selecting bar code type 
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7. Click on the Finish button to return to the label. 

8. Change the position of the bar code by selecting the bar code and dragging it to 

the desired position. 

9. Change the object size by dragging the object handles. The handles are small 

rectangles surrounding the object when it is selected. 

The label should now show the following: 

 

Label with text and bar code objects 

Insert Pictures 

The labeling software works with BMP, PCX, GIF, WMF, JPEG and many other 

popular graphic formats. 

1. To insert the picture, click on the   button in the Toolbox. 

2. Move the cursor to the desired position on the label and click on the mouse 

button. 

3. The Open dialog box will open allowing you to browse for your picture on your 

hard drive. Go to the folder Sample Graphics and select the picture 

LEISURE.WMF. Click on the Open button. 

The screen should show the following: 

 

Label with text, bar code and picture objects 
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Save a Label 

Always save your label during the design process. To save a label, do the following:  

1. Select the  icon. 

2. Type in the name of the label. For example, enter 'label' for the name of the 

label. 

3. The name of the label is visible in the program caption. 

 

Name of the label in the program caption 

Use Alignment Tools 

You have placed the objects on the label. Now you want to make sure they are aligned 

on the horizontal center of the label. You can align objects on the label by using the 

Align toolbar on the right side of the working window. 

To align objects on the label, do the following: 

1. Select all objects on the label. 

Note: 
The first object you select determines the alignment orientation for all selected 

objects. 

2. Choose a select arrow in the Toolbox and draw a frame around all objects to 

select all objects. 

 

Selecting the objects on the label 

3. In the Align toolbar on the right, click on the  icon  to arrange the objects. 

The selected objects will be rearranged and positioned on the horizontal center 

on the label. 

Note: 
There are also other alignment commands available in the Align Toolbar. 
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Note: 
You can also align the objects to the label grid. The option Snap to Grid is available in 

the View menu. 

Use Drawing Tools 

Now you will insert a line to separate a text object from other objects and a rectangle 

around the picture object. 

1. Select the  icon from Toolbox and move the cursor to the 

required starting point of the line. 

2. Press and hold down the mouse button while drawing the line. Move the mouse 

to the end position of the line and release the button. The Line object is placed 

on the label. 

3. Click on the  icon in the Toolbox and point the mouse to the 

upper left corner of the picture. 

4. Click and hold the mouse button while you stretch the rectangle to the lower 

right corner of the picture. 

5. To change the thickness of the vertical and horizontal line, double-click on the 

rectangle object to open its properties. Select the thickness you want and click 

on the Finish button. 

6. To edit the drawing object, double-click on the line or rectangle to open the 

dialog box with its properties. 

The label should show the following: 

 

Label with fixed objects 

Add Variable Fields 

Overview 

You may want to print the label on which the data changes for each label. The 

labeling software offers different variable fields (counters, date/time fields, operator's 

input from the keyboard) that you can use with text, graphics and bar code objects. 
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For this example a new label was created. The following steps explain how to create a 

label that contains a prompted field, a counter and date/time fields. The captions in the 

following screenshots were added separately. 

 

The left label shows design mode, the right two labels are two consecutive labels from 

print preview 

Create Keyboard Entry Variable Fields 

The content of a prompted field can be different for every print job. Before you print 

the label, you enter the value for the field. 

1. Click on the small arrow next to the  icon in the Toolbox to 

display a list of available variable types. 

2. Select New Keyboard Input from the list and click on the label where you 

want to position the object. 

A dialog box with the Variable Wizard will open. 

 

Creating new keyboard input variable field 

3. Type 'Enter product name' for the option Display this text to the print operator. 

4. Click on the Finish button. The cursor changes its shape to an arrow with a text 

object.  

5. Click on the label where you want to position the prompted field. 

The text object is placed on the label and linked to the new variable. 

Note: 
When you print the label, you will be prompted to enter the product name, which will 

be shown in preview on the label and on the printed label. 
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Create Serialized Data Variable Fields (Counters) 

Now create a counter field on the label. The value of that variable field will 

automatically increase by one on every label. 

1. Click on the small arrow next to the  icon in the Toolbox to 

display a list of available variable types. 

2. Select New Counter from the list. 

3. A dialog box with counter properties opens. 

 

Creating new counter variable field 

4. Leave everything as default so that the counter will always start from 1 and 

increase by one on each label.  

5. Click on the Finish button. 

6. Click on the label where the counter should be placed. 

The new variable is linked to the text object on the label. 

Note: 
Typically, the counter will increase by 1 on each label. For example, 1, 2, 3, 4, 5, etc. 

You can also define different incremental steps. 

Create Date and Time Variable Fields 

Content of the variable field can be filled automatically with the date or time stamp 

from the computer clock or printer clock (for supported printer models). 

1. Click on the small arrow next to the  icon in the Toolbox to 

display a list of available variable types. 

2. Select New Date Field from the list. A dialog box with date properties opens. 

 

Creating new date variable field 
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3. Leave everything as default and the date will be used on the label using the 

format as defined in your Windows operating system. 

To place a time stamp on the label, do the following: 

1. Click on the small arrow next to the  icon in the Toolbox to 

display a list of available variable types. 

2. Select New Time Field from the list.  

3. Click on the Finish button. 

4. Click on the label where the counter should be placed. 

The new variable is linked to the text object on the label. 

The date and time fields are updated when you preview or print the label. In this 

example the values will come from the system clock of your computer. 

Use Prefix or Suffix Options 

You can add a prefix and suffix to each variable field on the label. Both are added to 

the value when you preview and print the label. 

1. Click on the small arrow next to the  icon in the Toolbox to 

display a list of available variable types. 

2. Select New Keyboard Input from the list.  

3. A dialog box with variable properties will open. 

4. Type the text 'Enter product weight' for the option Display this text to the print 

operator. Set the allowable characters to digits and click on the Next button. 

5. Enter ' kg' for the Suffix option. 

 

Defining the variable suffix 

6. Click on the Finish button. 

7. Click on the label where you want to position the prompted field. 

The text object is placed on the label and linked to the new variable. When you 

will preview or print the label, the suffix ' kg' will be appended to the entered 

value on the right side. 

Change Printer Settings 

Change Common Printer Settings 

When you start designing a label you specify to which printer the label should be 

connected. Each label file remembers the printer settings for the selected printer 

driver on the label. 

As an example, you will change the printing speed and darkness. To change the 

printer settings, do the following: 
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1. Go to File – Printer Settings. The window with the printer settings will open. 

2. Open the Options tab. 

3. Change the Speed and Darkness options.  

4. Click on the OK button. 

5. Save the label by clicking the  button in the Standard toolbar or selecting 

the command Save in the File menu. 

 

Printer driver properties 

Note: 
Any changes in the printer settings dialog box will be saved to the label and applied to 

future print actions. 

You can also change the printer settings right before the label is printed. 

1. Select the Print command  in the File menu. 

2. Go to the Printer tab. 

This tab allows you to change the printer just before printing begins, but it also 

enables you to change common printer settings like speed, darkness and print 

direction. 

Note: 
Changes to the settings in the Printer tab will not be saved in the label but used only at 

print time. 

Change Dithering Options 

Dithering is a process of converting color or gray scale pictures to black and white 

pictures that can be printed on thermal printers. Thermal printers normally cannot 

print color images and can either print a dot on the label or not. There are no 

intermediate shades of grey. 

During the dithering process all colors and shades of grey in the picture are converted 

to black and white dots, creating the illusion of new colors and shades by varying the 

pattern of dots. Different shades of gray are produced by varying the patterns of black 

and white dots. There are no grey dots at all. In printing, dithering is usually called 

halftoning, and shades of gray are called halftones. 

To change the dithering settings, do the following: 

1. Go to File – Printer Settings. The window with the printer settings will open. 

2. Open the Dithering  tab. 



    Designing Labels 
      
      

  

47 

NiceLabel Express User Guide 

3. Change the Dithering type option to suit your needs. Look at the preview on the 

right side how you can expect the selected type to be applied on the label. 

4. Click on the OK button. 

5. Save the label by clicking the  button in the Standard toolbar or selecting 

the command Save in the File menu. 

  

Using Toolbars 

Using Standard Toolbar 

Click on the icons in the standard toolbar will execute the following actions: 

 Create new label. 

 
Open existing label. 

 
Save currently opened label. 

 
Cut the selected objects to clipboard. 

 
Copy the selected objects to clipboard. 

 
Paste the objects from the clipboard. 

 Undo last action. 

 
Redo last action. 

 
Access to the print functionality. Click on the small arrow for more 

commands. 

 
Access to the zoom functionality. Click on the small arrow for more 

commands. 

 
Access to the view functionality. Click on the small arrow for more 

commands. 

 Access to the variables. Click on the small arrow for more 

commands. 

 
Access to the databases. Click on the small arrow for more 

commands. 

 
Open the help file. 
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Using Toolbox 

To use the toolbox, do the following: 

1. Click on the icon in the toolbox to select the object. 

2. Move the mouse over the label. See how the cursors has changed. 

3. Click on the label where you want to place the selected object. 

Some objects have additional shortcut on the right side of the icon. Using this shortcut 

you can quickly create a new object with fixed content, create a new variable and 

connect it to the selected object or connect the object to one already defined variable. 

Using Text Toolbar 

You can use text toolbar to quickly format the text objects on the label. 

 

Here is how: 

1. First select it the text object by clicking it. 

2. Click the appropriate shortcut button in the text toolbar. 

3. To change the font, select the appropriate font from the list in the list box. 

Note: 
You can limit the display of fonts in the list. You can list all fonts on the system, only 

graphic fonts (truetype, opentype, type1, bitmap Windows fonts) or only thermal 

printer resident fonts. Click on the two icons next to the list of fonts. 

4. To change the size of the text, click on the list with font sizes and select 

appropriate size. You can also click on the buttons  and  that will enlarge/reduce 

the size of the font to the next step. 

Note: 
You can change the fonts size also directly on the label by resizing the text element 

with a mouse. 

5. To format the text bold, italic or underline, click on the appropriate formatting 

buttons. 

 
Formats the selected text in bold style. 

 
Formats the selected text in italic style. 

 
Formats the selected text in underline style. 

6. To change the alignment of the text object, click on the appropriate alignment 

buttons. 

Note: 
These buttons are accessible only for multi-line text objects. 

 Aligns text to the left edge. 

 
Aligns text to the horizontal center. 
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Aligns text to the right edge. 

  

Using Design Toolbar 

The design toolbar is used for: 

 Changing color of the objects. 

 Aligning objects. 

 Rotating objects. 

 Arranging objects. 

  

Working with Objects 

Defining Objects 

Defining Text Object 

To place the text object on the label, do the following: 

1. Click on the Text icon in the Toolbox. 

2. Click the position on the label, where you want to place the object. 

Text Wizard dialog box will open. 

3. Define the contents for the text object. 

4. Click on the Next button to advance to the next step of the wizard. 

5. Follow on-screen instructions in the next steps. 

6. Click on the Finish button. 

Note: 
Should you later want to edit the object, select it then double-click it. The wizard with 

properties appears. 

  

Defining Bar Code Object 

To place the bar code object on the label, do the following: 

1. Click on the Bar Code icon in the Toolbox. 

2. Click the position on the label, where you want to place the object. 

Bar Code Wizard dialog box will open. 

3. Define the contents for the bar code object. 

4. Click on the Next button to advance to the next step of the wizard. 

5. Follow on-screen instructions in the next steps. 

6. Click on the Finish button. 
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Note: 
Should you later want to edit the object, select it then double-click it. The wizard with 

properties appears. 

Defining Picture Object 

To place the picture object on the label, do the following: 

1. Click on the Picture object in the Toolbox. 

2. Click on the label, where you want to place the picture. 

The Open dialog box opens. 

3. Browse for the picture on the hard disk, then click on the Open button. 

Note: 
Should you later want to edit the object, select it then double-click it. The wizard or 

dialog box with properties appears. 

Defining Rectangle Object 

To place the rectangle object on the label, do the following: 

1. Click on the Rectangle icon in the Toolbox. 

2. Click the position on the label, where you want the upper-left position of the 

object to be set. 

3. Drag to bottom-right direction until the object size is as requested. 

4. The other method of positioning the rectangle object on the label is simply 

selecting the Rectangle tool and then clicking the label. A default-sized 

rectangle will appear and you can resize it using handles around the object. 

Note: 
If you want to draw a square, grab a handle a on one of the rectangle corners, 

simultaneously press and hold Shift key, then resize the rectangle. A square will be 

drawn. For more useful shortcuts available in the software refer to the chapter 

Shortcuts. 

4. To move a rectangle to a different position simply select it and drag it 

elsewhere on the label. 

Note: 
Should you later want to edit the object, select it then double-click it. The dialog box 

with properties appears. 

Defining Line Object 

To place the line object on the label, do the following: 

1. Click on the Line object in the Toolbox. 

2. Define the line starting point by clicking the mouse at the start position. 

3. Move the cursor to the end point, while holding down the mouse button. 

A line will be drawn from the left to right side of the label. 

../../../Content/Setting_up_Software/User_Interface/Keyboard_Shortcuts.htm
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Note: 
If you need to draw a vertical line, just click for starting point then drag the cursor in 

the up-down direction. 

Defining Ellipse Object 

To place the ellipse object on the label, do the following: 

1. Click on the Ellipse icon in the Toolbox. 

2. Click the position on the label, where you want the upper-left position of the 

object to be set. 

3. Drag to bottom-right direction until the object size is as requested. 

4. The other method of positioning the object on the label is simply selecting the 

Ellipse tool and then clicking the label. A default-sized ellipse will appear and 

you can resize it using handles around the object. 

Note: 
If you want to draw a circle, grab a handle a on one of the ellipse corners, 

simultaneously press and hold Shift key, then resize the ellipse. A circle will be 

drawn. For more useful shortcuts available in the software refer to the chapter 

Shortcuts. 

4. To move a ellipse to a different position simply select it and drag it elsewhere 

on the label. 

Defining Inverse Object 

To place the inverse object on the label, do the following: 

1. Click on the Inverse icon in the Toolbox. 

2. Click the position on the label, where you want the upper-left position of the 

object to be set. 

3. Drag to bottom-right direction until the object size is as requested. 

Note: 
If you want to draw a square, grab a handle a on one of the rectangle corners, 

simultaneously press and hold Shift key, then resize the rectangle. A square will be 

drawn. For more useful shortcuts available in the software refer to the chapter 

Shortcuts. 

4. To move a inverse to a different position simply select it and drag it elsewhere 

on the label. 

../../../Content/Setting_up_Software/User_Interface/Keyboard_Shortcuts.htm
../../../Content/Setting_up_Software/User_Interface/Keyboard_Shortcuts.htm
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Using Text Wizard 

Text Wizard 

 

First screen of Text Wizard 

Text Wizard guides you to define all parameters for the text object. 

Fixed text: Select this option if you would like to have a fixed non-changeable 

content of the object. If you select this option, you can enter the text directly in this 

dialog box. 

Variable text: Select this option, if you would like to have variable content of the 

object. Defining the content is defined in the next step. 

Font: Currently selected font type is shown in this field. 

 Inverse: Enable this option to use the text in inverse. 

Note: 
The option is not available for all printers. 

 Select button: You can select different font type for this text object among 

available fonts in the system. 
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Text Wizard - Choosing Variable Text 

 

Text Wizard - Choosing variable text 

Select the type of the variable field you want to use. If some of the option in the list is 

not accessible, the functionality is not available. 

Variable name: Type in the name of the variable that will be linked to the bar code 

object and will provide the value for it. 

The next page of the wizard depends on your selection here. 

Text Wizard - Keyboard Input 

Use this variable type when you want the operator to enter a value of the variable 

from the keyboard before printing the specified numbers of labels. 
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Dialog box for Text Wizard when Keyboard input option is chosen 

Prompt text for this variable field: Fill in the message that will be shown to the user 

when he will enter tne values for the variable field. 

Format: Select the format of data you allow to be entered for the variable field. 

Set maximum number of characters: Define the maximum length of characters that 

can be entered for the variable field. 

Text Wizard - Counter 

On this page of the wizard, you define the counter variable. 
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Dialog box for Text Wizard when Counter option is chosen 

Starting Value: Set the starting value for the counter. The counter will increment or 

decrement from the starting value. 

Note: 
You can enter only digits for the starting value. 

  

Prompt for value before print: Tick this option to enable entering the starting value 

of the counter when you start printing labels. Enter the text that will be shown to the 

user before printing. 

The message will be shown on the screen each time when the label is to be printed.  

Set maximum number of digits: Define the maximum length of digits the counter 

can occupy. 

Increment or decrement: You can define that the variable value will increase from 

label to label, or decrease. 

Preview: The field shows the preview of the counter, based on your selection. 

Text Wizard - Counter Continuation 

Step: Define the step for your counter. The counter will increase by this number on 

every label. 
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Change value every <n> labels: Define the number of labels, when the counter will 

change the value. 

Rollover when reached: Enter the value, when reached, will cause the counter to 

reset the value to the starting value. 

Text Wizard - Date Field 

Define the properties of the date field. The variable field will get the value from a 

computer clock. 

 

Dialog box for Text Wizard when Date field option is chosen 

Format: Select the format for your date from the list. You can also enter the 

custom format. 

Date offset: You can add a certain numbers of days, months or years to a current date 

and print that date instead of the current one. 

Preview: The printer will print the date as shown on the Preview field. This way you 

can see how the selected date format will look on the label. 

Text Wizard - Time Field 

Define the properties of the time field. The variable field will get the value from a 

computer clock. 
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Dialog box for Text Wizard when Time field option is chosen 

Format: Select the format for the time from the list. You can also enter the 

custom format. 

Preview: The printer will print the time as shown on the Preview field. This way you 

can see how the selected time format will look on the label. 

Text Wizard - Database 

Variable field linked to the database gets the value from the specified database field. 
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Dialog box for Text Wizard when Database option is chosen 

Define: Click on this button to open the database wizard that will help you define the 

link to the database. 

Field: Choose one of the available database fields as a source for the variable field. 

Length: Define the maximum length of the string in variable. If field in database 

contains more characters, they will not be printed. This option is useful if the field 

length in your database is not fixed (for example tab delimited ASCII file), or if you 

don't want to reserve space for all the characters in database's field. 

Text Wizard - Prefix and Suffix 

The variable element can have a prefix and suffix values. The prefix text is placed in 

front of the variable's value. The suffix text is place at the end of the variable's value. 
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Setting Prefix and Suffix string for the variable text element 

Note: 

If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable 

has set some value. If the variable is empty, the prefix/suffix will not be printed as 

well. 
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Using Bar Code Wizard 

Bar Code Wizard 

 

First page of bar code Wizard 

Bar Code Wizard guides you to define all parameters for the bar code object. 

Fixed bar code data: Select this option if you would like to have a fixed non-

changeable content of the object. If you select this option, you can enter the text 

directly in this dialog box. 

Variable text: Select this option, if you would like to have variable content of the 

object. Defining the content is defined in the next step. 

Note: 
When entering values for RSS composite bar codes, you need to provide the value for 

the linear and composite (2D) parts at the same time. 

Use the following syntax for entering values for RSS composite bar codes. The pipe 

character (|) is used to distinguish between the components. 

The syntax: <linear part>|<composite part> 

The example: 12345|description 

Bar Code Wizard - Choosing Variable Bar Code 

Select the type of the variable field you want to use. 
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Variable name: Type in the name of the variable that will be linked to the bar code 

object and will provide the value for it. 

The next page of the wizard depends on your selection here. 

Bar Code Wizard - Keyboard Input 

Use this variable type when you want the operator to enter a value of the variable 

from the keyboard before printing the specified numbers of labels. 

Prompt text for this variable field: Fill in the message that will be shown to the user 

when he will enter tne values for the variable field. 

Format: Select the format of data you allow to be entered for the variable field. 

Set maximum number of characters: Define the maximum length of characters that 

can be entered for the variable field. 

Bar Code Wizard - Counter 

On this page of the wizard, you define the counter variable. 

Starting Value: Set the starting value for the counter. The counter will increment or 

decrement from the starting value. 

Note: 
You can enter only digits for the starting value. 

  

Prompt for value before print: Tick this option to enable entering the starting value 

of the counter when you start printing labels. Enter the text that will be shown to the 

user before printing. 

The message will be shown on the screen each time when the label is to be printed.  

Set maximum number of digits: Define the maximum length of digits the counter 

can occupy. 

Increment or decrement: You can define that the variable value will increase from 

label to label, or decrease. 

Preview: The field shows the preview of the counter, based on your selection. 

Text Wizard - Counter Continuation 

Step: Define the step for your counter. The counter will increase by this number on 

every label. 

Change value every <n> labels: Define the number of labels, when the counter will 

change the value. 

Rollover when reached: Enter the value, when reached, will cause the counter to 

reset the value to the starting value. 
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Bar Code Wizard - Date Field 

Define the properties of the date field. The variable field will get the value from a 

computer clock. 

Format: Select the format for your date from the list. You can also enter the 

custom format. 

Date offset: You can add a certain numbers of days, months or years to a current date 

and print that date instead of the current one. 

Preview: The printer will print the date as shown on the Preview field. This way you 

can see how the selected date format will look on the label. 

Bar Code Wizard - Time Field 

Define the properties of the time field. The variable field will get the value from a 

computer clock. 

Format: Select the format for the time from the list. You can also enter the 

custom format. 

Preview: The printer will print the time as shown on the Preview field. This way you 

can see how the selected date format will look on the label. 

Bar Code Wizard - Database 

Variable field linked to the database gets the value from the specified database field. 

Define: Click on this button to open the database wizard that will help you define the 

link to the database. 

Field: Choose one of the available database fields as a source for the variable field. 

Length: Define the maximum length of the string in variable. If field in database 

contains more characters, they will not be printed. This option is useful if the field 

length in your database is not fixed (for example tab delimited ASCII file), or if you 

don't want to reserve space for all the characters in database's field. 

Bar Code Wizard - Prefix and Suffix 

The variable element can have a prefix and suffix values. The prefix text is placed in 

front of the variable's value. The suffix text is place at the end of the variable's value. 

Note: 

If you leave the edit fields empty, the prefix/suffix will not be used. 

Prefix and suffix can be used in situations where they are required only if the variable 

has set some value. If the variable is empty, the prefix/suffix will not be printed as 

well. 
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Using EAN.UCC 128 Wizard 

Using EAN.UCC 128 Wizard 

This wizard allows you to define the data structure for EAN.UCC 128 bar code. This 

kind of bar code has different areas of application that include trade items, logistic 

units, assets and locations. 

The EAN.UCC 128 bar code is an extremely flexible symbology. It allows 

representation of data of variable length, and makes it possible to encode several 

pieces of information in one bar code symbol. This is called concatenation. An 

Application Identifier is the field of two or more characters at the beginning of an 

data value. Application identifiers are prefixes that uniquely identify the meaning and 

the format of the data field following. The data fields are either of fixed or variable 

length, depending on the AI. 

Step 1: Choosing the application identifier 

 

EAN.UCC 128 Wizard: Choosing application identifier 

The dialog in the first step of Wizard allows you to select the EAN.UCC 128 bar code 

data structure. Each bar code is composed out of one or more Application Identifiers 

and the corresponding data. 
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Choose one of the Application Identifiers in this list. You can add, edit or delete 

Application Identifiers from the bar code later in the process. 

 

EAN.UCC 128 Wizard: How check digit should be applied 

If you have selected the Application Identifier which data includes a check digit (for 

example, AI (01) - GTIN, Global Trade Item Number), then first you will have to 

select how the check digit will be applied. The possible options are: 

 Automatic calculation: Check digit will be calculated by the application. 

 Check digit to be entered with data: Manually enter the data and check digit. 

The application will verify, if the entered check digit is valid. 
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Step 2: Application Identifier Input Type 

 

EAN.UCC 128 Wizard: Where the data for AI is obtained from 

When the Application Identifier is selected, you will have to define where is the data 

for its value obtained from. There are three possible options: 

 Fixed: The application identifier will have the fixed value on every label. 

 New variable: The application identifier will be linked to the variable and have 

variable value on each label. You will define a new variable. 

 Use existing variable: The application identifier will be linked to the variable 

and have variable value on each label. Select the existing variable from the list. 

Step 3: Entering the value for the Application Identifier 

Entering fixed value for the application identifier 
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Entering fixed value for the application identifier 

If you have selected fixed value in the previous dialog box, you should enter value for 

the Application Identifier here. The Wizard will let you know about the required data 

format fort this AI and how long the AI value should be. For some AI's the field 

length is fixed to certain number of digits, for others only the maximum number of 

possible digits is stated. You will also be reminded of the AI's proper field format 

(numeric, alphanumeric) if you enter incorrect data. 

Entering variable value for the application identifier 
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Creating new variable for the application identifier 

If you have selected new variable value in previous dialog box, a new variable field 

will be created. You will have to provide some information about variable being used. 

Calculating Check Digit 

Select how the check digit will be calculated. 

1. You can enter the check digit with the data and the software will validate it. 

2. The software can calculate the check digit. 

Defining New Variable 

Define the properties of the variable that will provide value for the application 

identifier. 

Prompt: Enter the text that will be displayed to the user at print time. 

Format: Define the format of the variable. 

Counter: If the variable will be a counter, define its properties. 
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Step 4: List of selected application identifiers 

 

Listing the selected application identifiers 

This is the last step of the EAN.UCC 128 Wizard. Here you can add, edit or delete 

Application Identifiers and define separator among them. 

Application Identifiers selected: In this field all selected application identifiers for 

the bar code are listed in the order of creation. You can change the order with the 

arrow buttons. 

Add, Edit or Delete buttons: Use these buttons to add additional application 

identifiers and edit or delete existing ones. 

Input Application identifier delimiter: Define left and right separator among 

different application identifiers. The default setting is to use round parenthesis. 

Preview: A sample bar code content based on your application identifier selection is 

shown here. 

Click the Finish button to exit the wizard. 
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Selecting Bar Code Type 

Settings for Advanced Bar Codes 

EAN.UCC 128 Bar Code 

This bar code is combined from one or more input values and standard AID - 

Application Identifiers. Each AID must be followed by the standard values. These 

values can be fixed or variable. 

When the EAN.UCC 128 bar code is selected, the Bar code data field in the Bar code 

Wizard dialog box is disabled. To define the contents of the bar code, click the Next 

button.  

From the list of available Application Identifiers select the first identifier. It will be 

written in bracket bellow the bar code. 

When the Application Identifier includes also check digits, you have to define 

whether it will be calculated or entered together with data. 

Next, define how you will set the values for the selected identifier. You may enter 

fixed value or define variable value.  

Fixed values 

When values are fixed, the Wizard dialog box will inform you what is expected to be 

entered – digits the maximum places... 

The defined AID is presented on the list of selected Application Identifiers. Click the 

Add button to add a new AID or on the Delete to delete existing one. 

Should you need to change the AID and the data, select the AID and click the Edit 

button. 

You can sort the listing of AID by using the Up and Down buttons.  

All the settings can be previewed on the Preview field.  

The separator among Application Identifier can be defined by entering the required 

separator for the left and for the right side of the Application Identifier. The default 

separator is bracket. 

Variable values 

EAN.UCC 128 bar code supports keyboard variables – the variable data will be 

entered from the keyboard. 

You can define the Prompt – the message for the operator, who will enter the data. 

The data can be numeric only or the operator is allowed to enter all characters. 

The value can be fixed or incremented/decremented on every label or certain number 

of labels with the desired step. 

The variable data will be written in the Preview field as a series of "A" character. 
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When you are satisfied with the settings, click the Finish to put the EAN.UCC 128 bar 

code to the label.  

PDF 417 2D Code 

General tab 

Y expansion factor 

This option defines the height of the bar code symbol. 

Security tab 

Accordingly to the standard, you can select among 9 levels of security. Higher 

security level allows more reliable reading regardless errors, but the bar code symbol 

is bigger. 

Truncated bar codes can be used where label damage is unlikely and there is no 

demand for very high level of security. The truncated symbol is smaller. 

Aspect Ratio 

It is the ratio between number of columns and number of rows. 

Contents 

PDF 417 code can encode: 

 Full 128 ASCII character set 

 All 128 Extended ASCII characters 

 8-bit binary data 

  

DataMatrix Bar Code 

General tab 

Y expansion factor 

This option defines the height of the bar code symbol. 

Aspect Ratio 
It is the ratio between number of columns and number of rows. Enter the wanted 

value in the fields. 

Details tab 

ECC Type 
Error Correction Codes define the security level. You can select one from the standard 

levels in the pull-down menu. 

Format ID 
This option defines which character set will be used in the bar code. You can select 

one of the formats with the following filter. 

01 and 11 0..9, space 
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02 and 12 A..Z, space 

03 and 13 A..Z, 0..9, space 

04 and 14 A..Z, 0..9, space,.-/ 

05 and 15 7-bit ASCII lower part (from 0 to 127) 

06 and 16 all 

07 and 17 7-bit ASCII 

  

The formats from 1 to 7 allow the data length to 500 characters, while formats from 

11 to 17 allow to 2000 characters. 

Border Size 

Factors from 1 to 15 set the dimension of the border in the shape of the character “L”. 

Data Matrix can encode: 

 Full 128 ASCII character set 

 All ISO characters 

 All EBCDIC characters 

MaxiCode 2D Code 

General tab 

Y expansion factor 

This option defines the height of the bar code symbol. 

Details tab 

When the option Structured is not selected, the content of the bar code is optional.  

For Structured bar code you may encode only standard contents. 

Edit Bar Code Dialog Box 

This dialog box is displayed when you click the Define button on the Bar Code dialog 

box. 

In this dialog box you specify the type of bar code you want to use on the label and all 

bar code properties: 

 How the bar code should be generated 

 Automatic or manual check digit calculation 

 Position of the human readable 

 Other options dependant on the bar code type 

Click the option Enable preview to preview the bar code. The bar code symbol was 

displayed on the right side of the dialog box. 



Designing Labels     
      
      

  

72 

NiceLabel Express User Guide 

Click the OK button to confirm the changes you made. 

Click the Cancel button to discard the changes. 

General Tab 

On this tab you can select the bar code type you want to use and the properties of the 

bar code. 

 

Edit bar code dialog box – General tab 

Type of bar code: The required bar code symbology is selected from the tree list 

of available bar codes. 

Symbol height: The height dimension of a bar code can be specified either by 

entering a value here or by resizing the bar code symbol directly on the label. 

Narrow bar width: The width of the narrowest bar in the bar code. This is the base 

bar width. The widths for all wider bars are calculated by the formula: 'narrow bar 

width' * 'ratio'. The result of the formula must be a whole number (it represents 

number of pixels).  

Ratio: This is the ratio between narrowest and widest bar in the bar code. The ratio is 

locked for majority of bar codes and you cannot change it. However, for some bar 

codes you can change it and adjust the bar code size to your needs. 

Print bar code as graphics: Select this option to convert the bar code object into the 

image and sent to the printer as image. If not selected, the bar code will print as 
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printer internal object. Printing bar codes as internal printer objects will speed up label 

printing, because less data must be transferred to the printer. 

Note: To disable the option Print bar code as graphics, you must use the printer 

drivers that ship with the software. 

Enable preview: Enable this option to see the preview of the selected bar code type. 

The preview will show on the right side of the dialog box.  

Check Digit Tab 

This tab is used to specify if you want to use the check digit in the bar code or not. 

This option can only be modified for the bar codes that allow you to enable and 

disable the check digit. 

Some bar code standards include the check-digit by the definition and it cannot be 

omitted. An example of such bar codes are EAN and UPC bar codes, where check 

digit cannot be disabled at all. But some codes allow you to freely enable/disable 

check-digit. 

Note: 
It is always recommended to include the check digit character in the bar code. It will 

increase the scanning reliability. 

 

Edit bar code dialog box – Check digit tab 

You can choose whether you want to input the check digit value, or let the program 

calculate it for you: 
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Auto-generate check digit: Check digit is calculated by the software. You must only 

enter the bar code data. For example: when using EAN-13 bar code input the first 12 

digits, check digit on 13th place will be calculated and added automatically. 

Verify the provided check digit: Use this command when you want to enter the 

value for the check-digit. At print time the entered check digit it will be verified for 

validity. 

Enable custom check digit algorithm: You can set some other algorithm you want 

to use for calculating the check digit. Click on the button Select to choose the 

algorithm. 

Human Readable Tab 

On this tab you can set the options regarding position and format of the bar code 

interpretation. 

No interpretation: Bar code object does not have any human interpretation. 

Below bar code: All data encoded in the bar code is placed beneath the bar code 

symbol as human readable characters. 

Above bar code: All data encoded in the bar code is placed above the bar code 

symbol as human readable characters. 

Font: Using the Font button, you can choose the suitable font for auto-translation 

text. The option Auto font scaling will adjust the font of the auto translation text to 

the size of the bar code. 

Note: 
You can only format the font for human interpretation, if the bar code is printed as 

graphics. When printing bar code as internal printer object, the printer will print the 

interpretation using resident built-in fonts. 

Contents mask sets the custom format of the human interpretation. 
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Edit bar code dialog box – Human readable tab 

  

Details Tab 

On this tab you can define advanced settings for the bar code. 

Note: 

Not all of these options are available for all bar codes and printers. 

Include quiet zones: By checking this field you set, that the bar code will have some 

white space in the front and in the end for increased readability. 

Descender bars: Some bars of a bar code will be longer than others. This is typically 

used with EAN and UPC bar codes that have longer bars in the begging, in the middle 

and in the end of the bar code. 

Mirror horizontally/mirror vertically: The bar code can be mirrored vertically and 

horizontally. bar code will usually have to be printed as graphics for this option to be 

accessible. 

Intercharacter gap: Some bar codes allow you to change the gap between characters 

in the bar code (e. g. Code-39). 

Include EAN white space: Before and after the bar code a special character is 

inserted, < or >. It indicates the width of the bar code. If you put any other object in 

the extent of the bar code, it will reduce the readability of the bar code. This option is 

only valid for EAN bar codes. 
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Edit bar code – Details tab 

Supported Bar Code Types 

Bar code 

Group 

Bar code Types 

EAN and 

UPC 

EAN-8, EAN-8 + 2-digit supplement, EAN-8 + 5-digit supplement, 

EAN-13, EAN-13 + 2-digit supplement, EAN-13 + 5-digit 

supplement, EAN-14, DUN-14, UPC Case Code, UPC-A, UPC-A + 

2-digit supplement, UPC-A + 5-digit supplement, UPC-E, UPC-E + 

2-digit supplement, UPC-E + 5-digit supplement, UPC-E(1), GS1-

128 (EAN.UCC 128), SSCC, Bookland, Addon 2, Addon 5 

Linear Interleaved 2 of 5, ITF 14, ITF 16, Code 39, Code 39 Tri Optic, 

Code 39 Full ASCII, Code 32, Code 93, CODE 128 (A, B and C 

subsets), Code 128 Pharmacy, MSI, Codabar, Postnet-32, Postnet-

37, Postnet-52, Postnest-62, Kix, Pharmacode, Plessy, Anker 

GS1 

Databar 
Linear GS1 Databar symbologies 
RSS14, RSS14 Truncated, RSS14 

Stacked, RSS14 Stacked Omnidirectional, RSS Limited, RSS 

Expanded 

Composite GS1 Databar symbologies 
RSS14, RSS14 Truncated, RSS14 Stacked, RSS14 Stacked 

Omnidirectional, RSS Limited, RSS Expanded, UPC-A, UPC-E, 

EAN-8, EAN-13, EAN.UCC 128 & CC-A/B, EAN.UCC 128 & 
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CC-C 

Two-

dimensional 

2D-Pharmacode, PDF-417, DataMatrix, MaxiCode, Aztec, QR, 

MicroQR, Codablock F, MicroPDF, InfoGlyph 

  

Selecting Objects 

To select two or more objects, you should press the <Shift> key, and hold down, 

while clicking the object with a mouse. 

The objects can be selected, cut, copied, pasted and edited with the right mouse 

button. If you click the right mouse button on the object, the menu shows all the 

available commands. Note that these commands are equivalent to correspondent menu 

commands. 

You can also change the anchoring point of a selected object by holding <CTRL> 

while clicking the placeholders (corners of the bounding box) of the object. 

  

Editing Objects 

To edit the properties of the object, do the following: 

1. Double-click the object on the label. 

The dialog box with object properties will open. 

Note: 

You can also press the <Enter> key, while the object is selected. 

2. Make modifications to the object properties. 

3. Click on the Finish button. 

Moving Objects 

To move the object on the label, do the following: 

1. Select the object. 

2. Click on the object with the left mouse button. 

3. Hold the mouse key pressed. 

4. Move the position of the cursor on the screen. 

The object will move with the cursor. 

Aligning Objects 

First you have to select objects that you want to align. 

Note: 

All objects are aligned relatively to the first selected object. 

Then click appropriate buttons in the Design toolbar to align selected objects to each 

other. If Align toolbar is not visible (by default it is located on the very right side of 

the window), enable the Design toolbar in Toolbar option in View menu. 

You can align objects to: 
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 Left 

 Right 

 Horizontal center 

 Top 

 Bottom 

 Vertical center 

You can also distribute object evenly, so that spacing between them is equal: 

 Horizontally 

 Vertically 

Note: 
If you hold the <CTRL> key while clicking the buttons, objects are aligned relative to 

label and not to the first selected object. 

The shortcut <Ctrl> + A opens the Align dialog box with same functionality as the 

Design toolbar. 

Resizing Objects 

To resize the object on the label, do the following: 

1. Select the object. 

The selected object is framed with a rectangle. 

2. Click on one of the small rectangles in the corners of the rectangle. 

3. Hold the mouse key pressed. 

4. Move the position of the cursor on the screen. 

The object will resize with the cursor. 

Rotating Label 

To rotate the label on the screen, do the following: 

1. Click on the  icon in the top left corner of label design area (where vertical 

and horizontal ruler collide). 

2. The label will rotate for 90° clockwise. 

Each click on the button will rotate the label for additional 90 degrees. The initial 

rotate position is portrait. Each click will rotate the label to the next position. The 

positions in line are: portrait, landscape, rotated portrait, rotated landscape. 

Rotating the label on screen will help you define label easier, when the objects on the 

label must be printed rotated, but you want to be able to design the label in the upside 

orientation. 

../../../Content/Interface_Reference/Transformations/Align.htm
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Note: If you do not use NiceDriver or your printer does not support 180° printing, 

then only two rotations are possible (portrait and landscape). 

  

Rotating Objects 

To rotate the object, do the following: 

1. Select the object. 

2. Click on the  icon in the design toolbar. 

The object will be rotated for 90° clockwise. 

Note: 
If the design toolbar is not visible, select the command Toolbars in the View menu, 

then click on the Design. 

Supported Graphics Formats 

The following graphical formats are supported: 

File extension Graphics type 

BMP, DIB, RLE Windows Bitmap 

GIF CompuServer Bitmap 

JPG, JPEGM JPE JPEG Bitmap 

TIFF, TIF, FAX, 

G3N, G3F 

TIFF Bitmap 

PNG Portable Network Graphics 

WMF Windows Metafile 

EMF Enhanced Windows Metafile 

ICO Windows Icon 

CUR Windows Cursor 

TGA, TARGA, 

VDA, ICB, VST, 

PIX 

Targa Bitmap 

PXM, PPM, 

PGM, PBM 

Portable Pixmap, GreyMap, 

BitMap 

JP2 JPEG2000 

J2K, JPC JPEG2000 Code Stream 

PCX Paintbrush 



Designing Labels     
      
      

  

80 

NiceLabel Express User Guide 

  

Working with Pictures 

Place pictures on the label 

Images can be various sizes. If the original size of the graphics is not valid for your 

label, you can freely resize the image by dragging the handles surrounding it. The 

image can be resized proportionally or stretched in both directions. 

The graphics objects can also be placed on the label from the clipboard or imported 

from another applications (i.e. Corel Draw, scanning programs...), using either the 

Insert Object or Paste command from the Edit menu. In this case, the graphics is 

embedded in the label file. The graphics is entirely stored in the label file, not 

separately on the hard disk. 

Note: When you insert the graphics as OLE object on the label (copy/paste from other 

software), the entire design environment of that other software is available in label 

design. When you double click such OLE object, that other application opens on the 

label. When using OLE object, the label processing might be slower. A label also 

occupies more space on the disk and takes more RAM. If possible, avoid using OLE 

objects on the label. 

Working with Variable Data 

Dynamic Data Overview 

You may want to print labels on which the data changes for each label, for example, 

counter, serial numbers, date and time. To accommodate the changing data, the 

application can easily be used to format labels using the variable fields. Variable field 

can be used with text and graphics objects. 

There are several types of variables you can choose to best suit your needs. Data, 

which must be printed as a variable, is prepared at the time of printing. It can be 

entered in the program from different ways: 

 by the operator from the keyboard 

 automatically from the computer’s clock (date and time) 

 automatically from the label design (using counters with predefined starting 

values and steps) 

 database can be used to provide data for the fields 

The variable data can be the same for many labels and/or specific for one label only.  

Working with Databases 

The labeling software allows you to use databases, in which your data is stored. 

Database type can be: 

1. ASCII (text file) where fields are fixed-length or are separated with any 

selected character. 

2. Microsoft Excel database. 
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You can use a single database on the same label. 

Database is very useful when printing labels with a large quantity of different data and 

variable values. You don't have to enter values for every variable before label 

production any more, you can use previously prepared database instead. Database in 

the ASCII text file can be created in any text editor (e.g. Notepad), it can be also 

exported from other applications (e.g. Microsoft Word. You can also use Microsoft 

Excel to edit your data. 

Before you can use the data from the database, you have to link the database on the 

label. During this process the database fields get connected to the variable fields on 

the label. 

When you start printing labels, every variable field will automatically get the value 

from the linked database field. Each record in the database is used on a single label. 

Using Data from the Databases 

Imagine that you have the following database that contains first and last names of the 

people: 

field1 field2 

John Smith 

Jane Wright 

Bob Doe 

1. To use the data on the label, you must first define this database using the 

Database Wizard. 

2. To include two variable texts on label create two text objects. 

3. In the text wizard select Variable contents and click on the Next button. 

4. Select the Database option as the source of variable data. 

5. Link both text objects to the variable fields. Each to a separate field. 

When you print the labels, each of the text objects on the label will get the value from 

the corresponding field in the database. When one label is printed, next record is used 

for the second label and process is repeated. Each name and surname are printed on 

the separate label. 

Database Wizard 

Using Database Wizard 

Process of defining a new Database access function consists of four steps (pages). On 

those pages you enter the data required by Wizard. You can go to the next step (page) 

by clicking Next button or return to previous with Previous button.  

When all data needed has been entered, Finish button will become available, allowing 

you to complete the process of defining a new Database access function. Note that 

some options have predefined values, so you don't really need to go through all the 

steps of a wizard.. 
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Selecting Database File 

 

Database wizard – Selecting database file 

Enter the full path name of the database file in edit box or use Browse button to find 

the file on your computer. 

Note: You can only select databases that are stored in files. If you use databases via 

ODBC or OLE DB drivers, you will have to set that manually in Database dialog box. 
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Selecting Desired Fields 

 

Database wizard – Selecting fields 

On this page you can select the fields you want to use on the label. All fields in a table 

are selected by default, but you will probably want to de-select some of them, 

especially if you have large table. Variable will be created for each selected field and 

can later be attached to objects. 
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Selecting Which Records will be Printed 

 

Database wizard – Selecting which records will be printed 

Select the desired option how you want to use the records in the database. By default 

the option I want to print all records from the table is set and all records in a table will 

be printed one at a time. Each record will be printed only once. 

If you do not want to print the entire database, you can select which records should be 

printed. In this case select the option I want to select which record to print. Prior 

printing you will be shown a dialog box with all records from the database. Then you 

will be able to select which records should be printed. 

By default records are used once for a single label. If you would like to print several 

copies of a label with database data, you can define it in the second part of this step of 

the Wizard. 

A field in table contains quantity to print option will let you chose some field in the 

database. This field has the information about the quantity of labels for each record. 

For example: You have database with records of your products. It contains a field 

with a numeric value, where the required number of label copies is stored. Select this 

field and let the application print the quantity of labels specified here. 

I will enter print quantity for each record: This option is only accessible if you 

have defined to select which records should be printed. Prior printing you will be able 
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to select which records will be printed in the selection dialog box. At the same time 

you will be able to type in the exact label copy for each selected record.  

Selecting Variable Quantity from the Database Field 

Select a field in the database that contains the label quantity information. The 

database record will be printed on as many consecutive labels as the selected field 

contains. 

Note: 

Make sure to select the field that has been formatted with the numeric data. 

Adding the Fields to the Label 

 

Database wizard – Adding fields to the label 

On this page you specify if you want the wizard to generate text objects on the label 

that are already linked to the corresponding fields in table. Text objects are created in 

upper left corner of a label, but you can later move them to another position. 
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Link Label to Text Databases 

Overview 

Text databases are text files containing data values that can be used for variable 

objects on the label. The text database is not a real database. It contains the data 

values but lacks the information of the data structure, name of the fields and 

maximum lengths of the fields. You have to provide the missing information before 

the labeling software can use the data from such a text database. 

 

The label in design mode (on the left) and preview of the five labels with data from 

the database 

Connect to a Database 

The labeling software offers a Database Wizard that guides you through the necessary 

steps to connect the database to a label. To connect your label to a database using the 

Database Wizard, do the following: 

1. Click on the  button in the Standard Toolbar. 

2. Click on the Browse button and point to the text database data.txt from sample 

folder.  
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Selecting the text database 

3. Click on the Next button. 

Note: 
If you connect to the database for the first time, you need to define the database 

structure. Continue with the next section. 

Format the Data with the Text File Wizard 

Because the text files do not contain the structural information like real databases do, 

you must define the fields and their data structure. When you use the same text 

database some other time, you won't have to define the structure again. 

1. Select the encoding of the data in your text file. The encoding selection is 

important when your file has multi-lingual contents (Unicode data). If in doubt 

what to use, first try the option Automatic detection. Refer to the preview, it 

must display to correct values. 
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Defining the file encoding 

2. Choose the data type for the selected text database. The fields are aligned in 

columns, so you must select the option Fixed.  
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Defining the type of the text database 

2. Click on the Next button. 

3. Define the widths of the individual columns by placing a break line before the 

second column and before the third column. 

 

Defining the fields in the text database 

4. Click on the Next button. 

5. Accept the default field names and click on the Next button. 

6. Review the text database structure. The field names and their maximum lengths 

are displayed. Click on the Finish button to close Text File Wizard. 

The link to the database has been created and database fields are available on the 

label.  

The labeling software brings you back to the Database Wizard. 

Place Database Fields on a Label 

The next step in the Database Wizard opens the dialog box with the list of available 

fields from the database.  

1. By default all fields from the database will be used on the label. Click on the 

Next button. 
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Using all fields in the text database 

2. Specify what records and how many you want to print: 

Select the options I want to select which record to print and I will enter label 

quantity for each selected record. Before printing labels, the table with the 

records will open and you will be able to select the records you want to print 

and the quantity of labels for each record. 

 

Specifying which records from the database will be printed and in what quantity 

3. Click on the Next button. 

4. Select if the Database Wizard should link all selected fields from the database 

to the text objects on the label or if you want to link the fields manually to the 

label.  

5. Click on the Next button.  

6. Select I want a text object for each selected field and click on the Finish button. 

 

Each field from the database will be linked to a text object 

The label will show several text objects. Every field from the database is linked with 

the text object on the label. 

Use Print Preview to Select Data an View a Label 

Now you will simulate label printing using print preview. 

1. Click on the print icon  in the Standard Toolbar. 

2. The Print dialog box opens with the Quantity of labels set to Variable quantity 

(entered for each database record). This setting corresponds to your selection 

in the Database Wizard when you have selected the options I want to select 

which record to print and I will enter label quantity for each selected 

record. 
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Only the records you select will be printed in the defined quantity. 

 

Print / Print preview dialog box 

3. To choose which records to print from the database click on the Select Records 

button. The Record Selection dialog box will open. 

4. Select the records from the database you want to print and enter the number of 

labels you want to print for each selected record. 

 

Record selection dialog box 

5. Click on the OK button. You will return to the Print dialog box. 

6. Click on the Preview button. Now you can preview the labels on the screen. 

Note that the text objects on the label change for each new record. 
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Preview of the second label in the series 

7. Click on the Next button in the command window to advance to the next label 

in the series. After you see the last label in the preview series, the application 

will re-open the Print dialog box. 

8. Click on the Close button to close the Print dialog box. 

Print a Label 

When you are certain that the label design is correct and label preview shows the 

correct values from the database, you can start sending the labels to the printer. To 

print a label, do the following: 

1. Click on the print icon  in the Standard Toolbar. 

The Print dialog box will open (same as the print preview dialog box). 

2. Click on the button Select Records and select the records you want to print and 

specify the label quantity for each record.  

 

Selecting records and specifying label quantity 

3. Click on the OK button. 
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4. Click on the Print button to start printing labels. 

5. Click on the Close button to close the dialog box. 

Using Text File Wizard 

Text File Wizard 

When the input database file is a plain ASCII text file or formatted CSV (Comma 

Separated Values), Text File Wizard will be started within Database Wizard and it 

will guide you through quick and easy steps of text data acquire. The main difference 

between real database and text file is in their data structure information. Databases 

include the whole information about their fields (names, data format, length) and can 

be automatically used with the application. Text files, on the other hand, do not have 

stored such information and you will have to instruct the application how the data is 

encoded. 

When Text File Wizard finishes, it will return control back to Database Wizard, that 

will guide the rest of the way. 

Choosing Data Type 

Before you can use text file, you will have to define its data structure. Fields can be 

delimited by some sort of a separator (tab, semicolon, comma or some entirely user-

defined separator) or can be of a fixed length. 

 

Database Wizard –Choosing Data Type 
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Choose Delimited, if you know that data fields are separated with some special 

character. File preview at the bottom of the dialog box can be helpful, if you do not 

know exactly how the data is organized. 

Choose Fixed if you know, that your data fields always occupy the same number of 

characters. 

Start import at row option is useful, when you do not want to import some rows at the 

top of the file. Most usual situation, when you would want to use this option is when 

text file contains some header on top of actual data fields. 

Setting the Fields 

 

Database Wizard –Setting separator and delimiter 

In the second step of the Text File Wizard you have to set the fields in the text file. If 

you have selected Delimited in the previous step, choose the appropriate separator 

here. The ones that are usually used with text files are already pre-defined. But if you 

require some other, there is an option to use a custom-defined one. 

You can also select the Delimiter character that is used when separator character is 

used in the text field itself. The delimiter should be used to enclose such field. Text 

between two delimiter characters is treated as one field although it contains the field 

separator character. 

The data preview in the bottom part of the dialog box will let you know if your choice 

of a separator character is a correct one. Fields will be separated with vertical lines, if 

a separator is valid. 
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Database Wizard –Setting column breaks 

If you have selected that your data is formatted with fixed widths, the second step of 

the Wizard will be slightly different. Instead of selecting character for field 

separation, you will have to define field widths. The Wizard makes is as simple as 

possible. Use a mouse and draw a vertical line to the start positions of the fields. Lines 

will indicate where the new field starts. 
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Formatting the Fields 

 

Database Wizard –Formatting the fields 

In this step of the Wizard you can review the fields' names and lengths and modify 

them, if necessary. You will probably use more friendly field names, so you can 

distinguish between them more easily. 

When you are finished with Text File Wizard, the structure information of the used 

text file is stored to a separate file with a extension of .SCH (Scheme File). If you will 

try to use the same text file some other time on a different label, you will be spared all 

efforts of structure creating. SCH file will be automatically used and Text File Wizard 

will be skipped entirely. 

Available Date Formats 

The date fields can be printed in various formats. In this field you define, how the date 

will look. You can select some of the predefined date formats or enter you own. When 

defining the formats, the following notation is used: 

D Number of the day in a month. Can occupy one or two characters. 

DD Number of the day in a month. Always occupies two characters. 

(leading zeros will be added as necessary). 

M M is number of the month. Can occupy one or two characters. 

MM MM is number of the month. Always occupies two characters. 



    Designing Labels 
      
      

  

97 

NiceLabel Express User Guide 

YY or 

YYYY 
The year as 2 or 4 digits number. 

DDD Abbreviation of the day of week name. 

DDDD The full day of week name. 

MMMM The full name of the month. 

MMM The abbreviation of the name of month. 

J The number of days since 1. January. Can occupy from one to three 

characters. 

JJJ The number of days since 1. January. Always occupies three 

characters. 

W The week number in current year. Can occupy one or two characters. 

WW The week number in current year. Always occupies two characters. 

  Any other sequence of characters will be displayed unchanged. This 

way you can insert dots, commas and other characters needed to 

properly write the date. 

  

The examples: 

Format How the date will look 

D/M/YYYY 10/3/2005 

DD/MM/YY 10/03/05 

DDDD, D. MMMM YYYY Thursday, 10. March 2005 

JJJWWYYYY 069102005 

Available Time Formats 

The time can be printed in various formats. In this field you define, how the time will 

look. You can select some of the predefined time formats or enter you own. When 

defining the formats, the following notation is used: 

h Hours in 12-hour format (AM/PM will be added if they follow the time). 

Can occupy one or two characters. 

hh Hours in 12-hour format (AM/PM will be added if they follow the time). 

Always occupies two characters. (leading zeros will be added as necessary). 

H Hours in 24-hour format. Can occupy one or two characters. 
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HH Hours in 24-hour format. Always occupies two characters. 

mm Used for minutes. 

ss Used for seconds. 

  

The examples: 

Format How the time will look 

h:mm {AM/PM} 8:25PM 

H:mm 20:25 

hh:mm:ss 08:25:36 

Using Contents Mask 

Contents mask is very useful when you must display the input data differently on the 

label. With contents mask you can simply reformat the data to suit your needs. 

For example, you must use differently formatted human interpretation text below bar 

code than the data is formatted in the bar code. You do not want to define two 

variables for this purpose and enter the similar data twice. 

The mask character will be replaced by the actual data and any other used character 

will be used as-is. If the current bar code value is 

"AD951" 

and the contents mask is 

"**C - ** /*/" 

the resulting output will be 

"ADC - 95 /1/" 

Powerful formatting structures can be defined using Contents mask, but it is only 

available with bar codes that allow custom formatting of the human interpretation. 

You should also make sure to print bar codes as graphics, otherwise the contents mask 

is not available. 

Note: 
If your data contains the asterisk "*" character, then you will have to change the 

default mask character to something else. It should be a unique value, not appearing 

anywhere in the data. 

The contents mask functionality is available with Text and Bar code objects. 
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Printing and Previewing 
Labels 

Previewing Pictures 

When you place a picture on the label, in design mode it is always shown in color-

depth as defined in the picture. 

However, when previewing the labels on-screen, the preview of the pictures depends 

on the dithering option set in the printer driver. All color pictures (except WMF and 

EMF files) are converted to monochrome images. The illusion of colors and shades of 

grey is accomplished by varying the pattern of dots. More dots close together will 

provide darker shade of grey. 

The preview of the label will show pictures in the same way as they will be printed 

accordingly to the dithering setting. More accurate print preview is guaranteed this 

way. 

If the picture is not previewed as you would like to print it, change the dithering 

setting in the printer driver. 

Preview and Print a Label 

If you want to print a label, you can use the print preview to simulate a print output. 

The label preview shows the label on the screen. 

Simulate printing 10 labels on the screen to check label layout and printing procedure. 

1. Click on  icon in the Standard toolbar or select the command 

Print in the File menu. The Print dialog box appears. 

2. Enter 10 for Label Quantity and click on the Preview button. The software will 

close the dialog box and simulate the production for 10 labels on the screen. 

Note: 
You can select between the quantity of the labels and the quantity of the pages. The 

page can have one or more labels and the labels are arranged on the page in columns 

and rows. If you have eight labels on the page, the quantity of ten pages will print 80 

labels. 

When you are certain that the labels will be printed correctly and the preview shows 

the correct values, you can proceed to real printing. To actually print the labels, do the 

following: 

1. Click on  icon in the Standard toolbar. The Print dialog box 

appears. 
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2. Enter 10 for the Label Quantity and click on the Print button. Your printer will 

now print 10 labels. 

Optimize the Printing Speed 

There are many factors that affect the printing speed. By following the guidelines 

below you can dramatically increase the speed of printing: 

 If your printer supports parallel and serial port, use the parallel port. Computer 

can send data to printer over parallel port much faster than over serial port. 

 Use printer's internal fonts instead of Windows' true-type fonts. True-type fonts 

must be sent to printer as graphics and therefore the size of data sent to printer 

is much bigger (couple of kilobytes). When using internal fonts, only the text is 

sent to printer (couple of bytes). 

 Avoid use of graphics on labels. 

 When using bar codes, make sure that you don't print bar codes as graphics, if 

your printer supports printing bar codes. 

 When using counters, the printer will internally increment the numbers if the 

internal fonts are used. (if supported by the printer) This means, that the printer 

will only receive the first number of object, and will later increment this 

number to print other labels. Using this option also reduces the amount of data 

transferred between computer and printer, but the difference is noticeable only 

with high quantity of labels. 

 Set the printing speed to a higher value (if your printer supports it). Note that 

setting the printing speed usually affects the quality of printing. The higher the 

speed, the lower the quality. You will have to find an acceptable compromise 

for this. 

 Don't print too much data on labels. If the speed of printing is an important 

factor, you should consider using preprinted labels, and only print the data, that 

is different on each label. 
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Technical Support 

Online Support 

You can find the latest builds, updates, workarounds for problems and Frequently 

Asked Questions (FAQ) on the product web site at www.nicelabel.com. If you cannot 

solve the problem on your own, please contact your local vendor or representative 

offices listed in the topic Contact Information. 

For more information please refer to: 

 Support FAQ: http://kb.nicelabel.com 

 NiceLabel FAQ: www.nicelabel.com/Learning-center/Sales-FAQ 

 NiceLabelTutorials: www.nicelabel.com/Learning-center/Tutorials 

 NiceLabel Forums: forums.nicelabel.com 

Contact Information 

Head Office 

Euro Plus d.o.o. 

Ulica Lojzeta Hrovata 4c 

SI-4000 Kranj 

Slovenia 

Tel: +386 4 280 50 00 

Fax: +386 4 233 11 48 

support@nicelabel.com 

www.nicelabel.com 

  

North American Office 

Niceware International, LLC. 

10437 Innovation Drive 

Suite 147 

Milwaukee, WI 53226 

Tel: +1 414 476 6423 

Fax: +1 414 476 7955 

Tech Support: +1 414 476 6408 

support@nicewareintl.com 

www.nicewareintl.com 

  

French Office 

http://kb.nicelabel.com/
http://www.nicelabel.com/Learning-center/Sales-FAQ
http://www.nicelabel.com/Learning-center/Tutorials
http://forums.nicelabel.com/
mailto:support@nicelabel.com
mailto:support@nicelabel.com
mailto:support@nicelabel.com
http://www.nicelabel.com/
mailto:support@nicewareintl.com
mailto:support@nicewareintl.com
mailto:support@nicewareintl.com
mailto:support@nicewareintl.com
mailto:support@nicewareintl.com
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Cobarsoft SARL 

Le rempart 

32320 Montesquiou 

France 

Tel: +33 (0) 562 709 201 

Fax: +33 (0) 562 708 004 

support@nicelabel.fr 

www.nicelabel.fr 

mailto:support@nicelabel.fr
mailto:support@nicelabel.fr
mailto:support@nicelabel.fr
mailto:support@nicelabel.fr
mailto:support@nicelabel.fr
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Glossary of Terms 
Auto translation 

Bar code interpretation in human readable characters. 

Darkness 

The print-head temperature defines the print darkness. The higher is the temperature, 

the darker is the printout. (thermal printers only) 

Descender bars 

Longer first and last bar in the EAN 13 bar codes. 

Quiet zone 

The empty place before and after the bar code symbol. This is necessary for the bar 

code reader to properly read the bar code. 

Security 

The definition of the control check-digit with some bar code types. 

  


